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ВВЕДЕНИЕ 
В процессе изучения поведенческих актов живых существ в начале 

XX века исследователи стали сопоставлять зримые эффекты с активностью 
в нервных структурах. Удалось установить связь некоторых дисфункций 
организма с характерными особенностями функционирования нервных 
клеток. Получили объяснение эффекты действия электрического тока на 
живую материю. Все это привело к всплеску интереса к биологическим 
нервным сетям. Стало очевидно, что феномен человеческого интеллекта, 
такие функции мозга как память, способность к обучению и обобщению 
реализуются громадным числом нейронов, связанных друг с другом. 

Тогда же, в 30-е годы, были опубликованы первые труды по 
кибернетике, науке об управлении. Часть исследователей занялась 
изучением информационных процессов в биологических нейронных сетях.  
Проводить опыты на биологических нейронах оказалось чрезвычайно 
сложно в силу трехмерности их расположения в живой материи и малых 
размеров клеток. Поэтому распространение получили разнообразные 
формальные модели. Предмет исследования стал называться 
искусственные нейронные сети. 

Можно выделить несколько компонент искусственной нейронной 
сети, определяющих ее свойства: 

• Нейроны, образующие сеть. 
• Архитектура нейронной сети. 
• Метод обучения нейронной сети. 

Во многом эти составляющие взаимосвязаны. В частности, метод 
обучения неявно подразумевает некоторую архитектуру связи нейронов и 
их свойства. Поэтому, несмотря на наличие в литературе некоторой 
номенклатуры компонент, рассматриваются они, как правило, совместно. 
Совокупность некоторых компонент и правило построения из них 
нейросети называется нейросетевой парадигмой. 

На конец XX века в мире были известны более четырех десятков 
различных нейросетевых парадигм и множество их разновидностей.  В 
последние годы обнаруживается значительный рост интереса к 
искусственным нейронным сетям благодаря возросшим возможностям 
вычислительной техники.  Нейронные сети успешно применяются для 
решения практических задач в различных прикладных областях. 

Теоретические основы 
Искусственный нейрон 

Основным элементом искусственной нейронной сети является 
формальный нейрон (рис. 1), выполняющий нелинейное преобразование 
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Рисунок 1: Формальный нейрон 

На вход формального нейрона поступает некоторое множество 
сигналов x1, x2,…, xn , каждый из которых может являться выходом другого 
нейрона. Эти входные сигналы, в совокупности обозначаемые вектором X, 
соответствуют сигналам, приходящим в синапсы биологического нейрона. 
Каждый сигнал умножается на соответствующий вес w1, w2,…, wn, и 
поступает на суммирующий блок, обозначенный Σ. Каждый вес 
соответствует «силе» одной биологической синаптической связи. 
(Множество весов в совокупности обозначается вектором W.) 
Суммирующий блок, соответствующий телу биологического элемента, 
складывает взвешенные входы алгебраически, создавая выход, 
обозначенный как S. В векторных обозначениях это может быть записано 
следующим образом: S = XW. Сигнал S далее преобразуется 
активационной функцией F и дает выходной нейронный сигнал y: 

𝑦𝑦 = 𝐹𝐹(𝑆𝑆) = 𝐹𝐹(∑ 𝑤𝑤𝑗𝑗𝑥𝑥𝑗𝑗𝑛𝑛
𝑗𝑗=1 ) (1) 

Функция, используемая в качестве активационной, может быть 
различной и определяется решаемой задачей и типом нейронной сети. 
Наиболее распространенные функции изображены на рис.2 и в таблице 1.  

 
Рис.2. Активационные функции: a) Сигмоидная (логистическая), b) 
пороговая, c) линейная ограниченная. 
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Таблица 1. Функции активации 
Название функции y=𝐹𝐹(𝑆𝑆) 𝐹𝐹′(𝑆𝑆) Параметры 
Линейная 𝑘𝑘𝑘𝑘 k k=const,  

коэффициент наклона 
прямой 

Пороговая �1, 𝑆𝑆 > 0
0, 𝑆𝑆 ≤ 0   

Линейная 
ограниченная �

𝑝𝑝, 𝑆𝑆 > 0
−𝑝𝑝, 𝑆𝑆 < −𝛼𝛼
𝑆𝑆,−𝛼𝛼 ≤ 𝑆𝑆 ≤ 𝛼𝛼

 
  

Модифицированна
я пороговая 𝑦𝑦(𝑡𝑡 + 1) = �

1, 𝑆𝑆 > 0
𝑦𝑦(𝑡𝑡), 𝑆𝑆 = 0
−1, 𝑆𝑆 < 0

 
 𝑡𝑡-параметр времени 

Сигмоидная 1
1 + 𝑒𝑒−𝑐𝑐𝑐𝑐

 𝑦𝑦(1 − 𝑦𝑦) c > 0, характеризует 
ширину функции по оси 
абсцисс 

Биполярная 
сигмоидная 

2
1 + 𝑒𝑒−𝑆𝑆

− 1 
1
2

(1 − 𝑦𝑦2)  

Гиперболический 
тангенс 𝑡𝑡ℎ(𝑐𝑐𝑐𝑐) =

𝑒𝑒𝑐𝑐𝑐𝑐 − 𝑒𝑒−𝑐𝑐𝑐𝑐

𝑒𝑒𝑐𝑐𝑐𝑐 + 𝑒𝑒−𝑐𝑐𝑐𝑐
 

(1 − 𝑦𝑦2) c > 0, характеризует 
ширину функции по оси 
абсцисс 

Радиально-
базисная 𝑒𝑒𝑒𝑒𝑒𝑒(

−0.5𝑆𝑆2

2𝜎𝜎2
) 

 𝜎𝜎-среднеквадратичское 
отклонение, 
характеризующее ширину 
функции 

Следует отметить, что в некоторых случаях, например, для радиально-
базисной функции, величина S может рассчитываться как евклидово 
расстояние между входным и весовым векторами: 

𝑆𝑆 = �∑ (𝑥𝑥𝑗𝑗 − 𝑤𝑤𝑗𝑗)2𝑛𝑛
𝑗𝑗=1 �0.5 (2) 

 
Архитектура искусственной нейронной сети 

В биологических нейронных сетях имеют место разнообразные 
соединения нервных клеток. В зависимости от типа клеток и их функций 
связи могут быть как локальным (в пределах нескольких миллиметров), 
так и весьма протяженными (десятки сантиметров). Некоторые нервные 
клетки соединяются друг с другом вполне регулярно (например, глазной 
нерв), другие же связаны на первый взгляд хаотично. В живом организме 
связи между нейронами могут исчезать, могут появляться, вырастать. 
Механизм и причины такого свойства связей во многом неизвестен. 

В искусственных нейронных сетях используются гораздо более 
простые схемы связей между нейронами. Во-первых, это группирование 
нейронных элементов в виде слоев. Нейронный слой – это линейка или 
матрица, обычно, однотипных нейронов, на которые в каждый такт 
времени параллельно поступают сигналы от других нейронов сети. 
Правила соединения между слоями, а также внутри слоя формализованы. 
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Рисунок 33 демонстрирует два примера связи нейронных слоев. Вариант 
(а) соответствует полносвязному соединению входов нейронов 2-го слоя с 
выходами нейронов 1-го слоя. Вариант (б) демонстрирует наличие области 
связи размером 3: выходы только трех ближайших нейронов слоя №1 
подаются на вход нейрона слоя №2. Область связи используется в том 
случае, когда необходимо гарантировать отсутствие влияния далеко 
расположенных нейронов предыдущего слоя. 

 
Рисунок 3: Соединение нейроных слоев 

Во-вторых, все возможные связи в искусственных нейронных сетях 
определяются заранее. Если же в процессе обучения оказалось, что 
некоторые связи не нужны для получения желаемого выхода, им 
присваивается вес 0, что равносильно исчезновению соединения между 
двумя нервными клетками в организме. 

 
Рисунок 4: Обобщенная архитектура нейронной сети 

Достаточно общая модель архитектуры искусственных нейронных 
сетей представлена в работе [1] (Рисунок 44). Она является многослойной и 
включает в себя прямые, перекрестные и обратные связи между слоями. 
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Входной слой обычно состоит из нейронов с линейной функцией 
активации и выполняет распределительные функции. Скрытые слои 
осуществляют функции обработки информации. Выходной слой также 
служит для обработки информации от предыдущих слоев и формирует 
результат работы нейронной сети. 

 
Примеры архитектур для решения типовых задач 
На рис. 6 изображено несколько типовых архитектур нейронных 

сетей. С помощью многослойного персептрона (рис.6а) можно решать 
задачи классификации. 

  
а) б) 

  
в) г) 

Рисунок 6: Типовые архитектуры нейронных сетей: а) многослойный персептрон; б) 
автоассоциативная сеть; в) сеть Кохонена; г) сеть встречного распространения сигнала. 

Автоассоциативная сеть (рис.6б) позволяет сжимать данные и 
производить одноклассовую классификацию Нейронная сеть Кохонена 
(рис.6в) осуществляет топологическое упорядочивание входного 
пространства данных и широко применяется в задачах распознавания 
образов.  Сеть Кохонена осуществляет разбиение n-мерного пространства 
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на m областей решений, каждой из которых соответствует отдельный 
нейрон.  Сеть встречного распространения позволяет решать задачи 
кластеризации и классификации (рис.6г). 

Методы обучения 
Под обучением нейронной сети обычно понимается настройка 

весовых коэффициентов (или других характерных параметров) нейронов, 
обеспечивающая решение нейронной сетью в режиме функционирования 
поставленной задачи с заданной точностью. До начала обучения 
необходимо полностью задать архитектуру нейронной сети, то есть 
выбрать количество нейронных слоев и нейронов в них, тип нейронов, вид 
функций активации, установить соединения между слоями и нейронами, 
определить наличие латеральных связей, задать размеры рецептивных 
областей.  

В зависимости от специфики прикладной области обучение 
нейронной сети может производится однажды, эпизодически или 
постоянно. Первый случай имеет место, когда нейронная сеть 
предназначена для работы в неизменных условиях. Второй случай 
соответствует плавно или редко меняющимся внешним условиям, когда 
необходимость дообучения определяется некоторым критерием. В третьем 
случае речь идет об адаптивной системе, обучающейся в процессе 
функционирования. 

Можно выделить три подхода к обучению искусственных нейронных 
сетей: 

• аналитическое обучение; 
• обучение с учителем; 
• обучение без учителя. 

Суть аналитического обучения сводится к построению нейросетевого 
алгоритма, оптимизирующего качество функционирования нейронной сети 
для решения конкретной задачи [2][3]. В некоторых случаях удается 
непосредственно из постановки задачи сформулировать алгоритм расчета 
весовых коэффициентов. Обучение как таковое сводится к заданию 
рассчитанных весовых коэффициентов [3]. Очевидно, что данный подход 
применим не всегда. С одной стороны, в процессе проектирования 
нейронной сети инженер получает оценки точности и предсказуемости 
функционирования целевой нейронной сети. С другой стороны, детальный 
анализ предметной области перекладывает интеллектуальную нагрузку 
выявления закономерностей с нейронной сети на плечи инженера, что, 
вообще говоря, является отрицанием самой идеи использования 
нейронных сетей в качестве носителей искусственного интеллекта.  
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Методы обучения с учителем 
Обучение с учителем подразумевает наличие априорных знаний о 

входных и соответствующих им выходных данных. Как правило, эти 
данные называются обучающим набором и представлены парами вход – 
желаемый выход. Аналогичный способ обучения применяется и в 
биологических системах. 

К достоинствам обучения с учителем можно отнести неявную 
передачу знаний о предметной области в нейросеть (без предварительной 
детальной формализации человеком), универсальность подхода и 
возможность учиться как на модельных, так и на реальных данных. 
Основным недостатком этого подхода к обучению является необходимость 
знания выходных данных, которые в ряде ситуаций получить сложно или 
даже невозможно (например, в задаче управления атомным реактором в 
аварийном режиме). Выходные данные, полученные на модели, могут быть 
неточными в силу приблизительности самой модели. 

В подходе обучения с учителем обычно используют:  
• метод обратного распространения ошибки 
• квазиньютоновский метод 
• метод Левенберга-Маркварда 
• метод сопряженных градиентов 

Метод обратного распространения ошибки [4][5] применяется для 
обучения многослойных сетей без перекрестных и обратных связей. 
Обучение сводится к минимизации среднеквадратичной ошибки 
нейронной сети с помощью метода градиентного спуска в пространстве 
весовых коэффициентов и порогов нейронной сети:  

min
𝑤𝑤𝑖𝑖𝑖𝑖,𝑇𝑇𝑗𝑗

1
𝑃𝑃
∑ 𝐸𝐸𝑝𝑝𝑃𝑃
𝑝𝑝=1                𝐸𝐸𝑝𝑝 = 1

2
∑ �𝑦𝑦𝑗𝑗 − 𝑡𝑡𝑗𝑗�

2𝑁𝑁𝐿𝐿
𝑗𝑗=1 , 

где 𝑁𝑁𝐿𝐿 – количество нейронов в последнем L-ом слое нейронной сети; 
𝑦𝑦𝑗𝑗 – выход j-го нейрона последнего слоя; 𝑡𝑡𝑗𝑗 – эталонное значение 

выхода j-го нейрона последнего слоя; 𝐸𝐸𝑝𝑝 – среднеквадратичная ошибка 
нейронного сети при подаче на вход p-го входного образа из обучающего 
набора данных. 

𝑦𝑦𝑗𝑗 = 𝐹𝐹�𝑆𝑆𝑗𝑗� = 𝐹𝐹�∑ 𝑤𝑤𝑖𝑖𝑖𝑖𝑦𝑦𝑖𝑖𝑛𝑛
𝑖𝑖=1 −  𝑇𝑇𝑗𝑗�,   (3) 

здесь 𝑦𝑦𝑖𝑖  – выход i-го нейрона предпоследнего слоя; 𝑤𝑤𝑖𝑖𝑖𝑖 – весовой 
коэффициент связи между i-м нейроном предпоследнего слоя и j-м 
нейроном последнего слоя. 𝑇𝑇𝑗𝑗 – пороговое значение j-го нейрона 
выходного слоя, определяющее сдвиг функции активации по оси абсцисс; 
n – количество нейронов в предпоследнем слое.  

Весовые коэффициенты и пороговые значения в процессе обучения 
изменяется согласно выражениям: 
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𝑤𝑤𝑖𝑖𝑖𝑖(𝑡𝑡 + 1) = 𝑤𝑤𝑖𝑖𝑖𝑖(𝑡𝑡) −  𝛼𝛼 𝜕𝜕𝐸𝐸𝑝𝑝
𝜕𝜕𝑤𝑤𝑖𝑖𝑖𝑖(𝑡𝑡)

= 𝑤𝑤𝑖𝑖𝑖𝑖(𝑡𝑡)−  𝛼𝛼𝛿𝛿𝑗𝑗𝑙𝑙𝐹𝐹′(𝑆𝑆𝑗𝑗)𝑦𝑦𝑖𝑖  (4) 

𝑇𝑇𝑗𝑗(𝑡𝑡 + 1) = 𝑇𝑇𝑗𝑗(𝑡𝑡)−  𝛼𝛼 𝜕𝜕𝐸𝐸𝑝𝑝
𝜕𝜕𝑇𝑇𝑗𝑗(𝑡𝑡)

= 𝑇𝑇𝑗𝑗(𝑡𝑡)−  𝛼𝛼𝛿𝛿𝑗𝑗𝑙𝑙𝐹𝐹′(𝑆𝑆𝑗𝑗)   (5) 

где 𝛼𝛼 ∈ (0,1) — коэффициент скорости обучения; 𝛿𝛿𝑗𝑗𝑙𝑙 — ошибка, передаваемая 
через 𝑗𝑗-й нейрон слоя 𝑙𝑙 в обратном направлении. Эта ошибка вычисляется 
по следующему правилу: 

𝛿𝛿𝑗𝑗𝑙𝑙 = �
    (𝑡𝑡𝑗𝑗 − 𝑦𝑦𝑗𝑗 ), 𝑙𝑙 = 𝐿𝐿;

�∑ 𝛿𝛿𝑟𝑟𝑙𝑙+1𝐹𝐹′(𝑆𝑆𝑟𝑟)𝑤𝑤𝑗𝑗𝑗𝑗𝑙𝑙+1
𝑁𝑁𝑙𝑙+1
𝑟𝑟=1 �, 1 ≤ 𝑙𝑙 < 𝐿𝐿

   (6) 

Алгоритм обучения метода обратного распространения ошибки 
состоит из следующих шагов: 

 
1. Задают шаг обучения α  (0<α <1)  и желаемую 

среднеквадратичную ошибку Еm 
2. Случайным образом инициализируются весовые коэффициенты и 

пороговые значения нейронной сети. 
3. Последовательно подаются на вход сети входные образы из 

обучающей выборки. Для каждого входного образа выполняются 
следующие действия: 
3.1. Производится фаза прямого распространения входного образа 

по нейронной сети с вычислением выходов всех нейронных 
элементов сети по формуле  

),(∑ −=
i

jiijj TywFy  

где индекс j характеризует нейроны следующего слоя по 
отношению к слою i.  

3.2. Осуществляется фаза обратного распространения сигнала, в 
результате которой определяется ошибка jδ , j=1,2,… 
нейронных элементов для всех слоев сети. 

3.3. Происходит изменение весовых коэффициентов и порогов для 
каждого слоя нейронной сети по формулам (4) и (5). 

4. Вычисляется суммарная среднеквадратичная ошибка нейронной 
сети 

∑∑
=

−=
P

k j

k
j

k
j tyE

1

2)(
2
1      P – размерность обучающей выборки. 

5. Если E>Em , то происходит переход к шагу 3 . В противном случае 
обучение заканчивается. 

Обучение по методу обратного распространения ошибки имеет два 
существенных недостатка: большое время обучения (для получения 
приемлемых по точности результатов) и сбои в обучении, связанные с 
локальными минимумами. 
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На скорость процесса обучения влияют выбранное значение шага 
обучения  𝛼𝛼, начальная инициализация весовых коэффициентов, 
архитектура сети (количество слоев, нейронов, вид функций активации). 
Например, для сигмоидной функции активации при задании больших 
(положительных и отрицательных) начальных значений весовых 
коэффициентов выходная активность нейронов будет близка к 1 или 0, а 
значит изменения весовых коэффициентов будут незначительными. Это 
может привести либо к остановке в точке локального минимума 
среднеквадратичной функции ошибки, либо к значительной длительности 
процесса обучения. Выбор начального шага обучения 𝛼𝛼 близким к 1 может 
сделать процесс обучения расходящимся или привести к пропуску 
глобального минимума среднеквадратичной ошибки. Значения 𝛼𝛼 ≈ 0 
увеличивают длительность обучения и могут привести к остановке 
обучения в точке локального минимума. Все это иногда делает процесс 
обучения нейронной сети до приемлемой точности решения задачи 
сложным и многоэтапным. Существует ряд рекомендаций по выбору 
начальных значений весовых коэффициентов и шага обучения.  

Весовые коэффициенты можно: 
1) задавать согласно выражению 𝑤𝑤𝑖𝑖𝑖𝑖 ≈

1
�𝑛𝑛(𝑖𝑖)

, где 𝑛𝑛(𝑖𝑖) – число 

нейронов в i-м слое; 
2) инициализировать случайным образом в диапазоне [-0.05; 0.05] 

или [-0.1; 0.1]. 
Для выхода из небольших локальных минимумов 

среднеквадратичной ошибки изменение весовых коэффициентов в 
алгоритме обучения предлагается модифицировать следующим образом []: 
 )()()()1()1( twySFtwtwtw ijijjijijij ∆+′−=−+=+∆ γαδ ,  
где γ – моментный параметр, выбирающийся из диапазона [0;1]. 
Моментный параметр является подобием памяти последнего изменения 
веса: при его значении, близком к единице, значительное влияние на шаг 
градиентной оптимизации оказывает предыдущее значение шага. 

Тогда общую рекомендацию к выбору шага обучения и моментного 
параметра можно сформулировать таким образом:  

1) выбирать большим начальный шаг обучения с целью быстрого 
поиска глобального минимума и уменьшать его по мере 
приближения к заданному числу итераций или выбранной 
среднеквадратичной ошибки Еm для более точной настройки весов;  

2) начальное значение моментного параметра γ  выбирать из 
диапазона [0.7;0.9], и в процессе обучения уменьшать до 0. 

Также можно использовать адаптивный шаг обучения, найденный по 
методу наискорейшего спуска []. 
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Процедура обучения обратным распространением ошибки 
применяется в двух режимах: оперативном и пакетном. Оперативное 
обучение подразумевает, как и описывалось выше, коррекцию весовых 
коэффициентов после предъявления каждой обучающей пары. Пакетный 
режим предусматривает накопление изменений весов на протяжении 
некоторой эпохи без изменений самих весовых коэффициентов. Обычно 
временная протяженность эпохи соответствует предъявлению всего 
множества обучающих пар один раз. По окончании эпохи веса 
корректируются полученными кумулятивными значениями. Дальше 
процесс итеративно повторяется. 

Ускорение обучения 
Как уже отмечалось, обучение по методу обратного распространения 

ошибки является эквивалентом оптимизации функции стоимости 𝐶𝐶(𝑥𝑥) в 
пространстве 𝑥𝑥 ∈ ℝ𝑛𝑛 без дополнительных ограничений. 

min
𝑥𝑥∈ℝ𝑛𝑛

𝐶𝐶(𝑥𝑥) 
При этом описанный алгоритм поиска оптимума демонстрирует 

линейную сходимость (без использования моментума): 
𝑥𝑥𝑘𝑘+1 = 𝑥𝑥𝑘𝑘 − 𝜂𝜂𝑘𝑘∇𝐶𝐶(𝑥𝑥𝑘𝑘) 

Низкая скорость обучения определяется линейностью сходимости 
используемого алгоритма оптимизации, опирающегося только на первую 
производную функции стоимости 𝐶𝐶(𝑥𝑥). Поэтому для улучшения этого 
параметра применяются более сложные схемы [5]. 

Представим 𝐶𝐶(𝑥𝑥) вблизи точки 𝑥𝑥0 ∈ ℝ𝑛𝑛 рядом Тейлора до второй 
производной включительно: 

𝐶𝐶(𝑥𝑥) = 𝐶𝐶(𝑥𝑥0) + 𝑔𝑔𝑇𝑇Δ𝑥𝑥 + 1
2
Δ𝑥𝑥𝑇𝑇𝐻𝐻Δ𝑥𝑥     (7) 

где Δ𝑥𝑥 = 𝑥𝑥 − 𝑥𝑥0 — шаг, 𝑔𝑔 = ∇𝐶𝐶(𝑥𝑥0) – градиент в точке 𝑥𝑥0, 𝐻𝐻 = ∇2𝐶𝐶(𝑥𝑥0). Из 
выражения (1) следует значение оптимального шага: 

𝜕𝜕𝐶𝐶
𝜕𝜕(Δ𝑥𝑥)

= 𝑔𝑔 + 𝐻𝐻Δ𝑥𝑥 = 0      ⇒      Δ𝑥𝑥 = −𝐻𝐻−1𝑔𝑔 
Записанное правило вычисления шага называется методом Ньютона 

и соответствует квадратичной сходимости, ускоряющей процесс обучения. 
В методе Левенберга-Маркварда (Levenberg-Marquadt) вводится 

дополнительное ограничение на шаг ‖Δ𝑥𝑥‖2 = 1: 
𝐿𝐿(Δ𝑥𝑥, 𝜆𝜆) = 𝐶𝐶(𝑥𝑥0) + 𝑔𝑔𝑇𝑇Δ𝑥𝑥 +

1
2
Δ𝑥𝑥 +

1
2
𝜆𝜆(Δ𝑥𝑥𝑇𝑇Δ𝑥𝑥 − 1) 

Условие оптимальности: 
𝜕𝜕𝜕𝜕

𝜕𝜕(Δ𝑥𝑥) = 𝑔𝑔 + 𝐻𝐻Δ𝑥𝑥 + 𝜆𝜆Δ𝑥𝑥 = 0     ⇒      Δ𝑥𝑥 = −[𝐻𝐻 + 𝜆𝜆𝜆𝜆]−1𝑔𝑔 
При 𝜆𝜆 = 0 формула для вычисления шага сводится к методу Ньютона. 

Для больших значений 𝜆𝜆 формула соответствует градиентному спуску в 
стандартном методе обучения. 

Основной недостаток метода Ньютона применительно к его 
прикладному применению заключается в необходимости расчета 𝐻𝐻, то 
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есть, в вычислении второй производной функции стоимости. На практике 
это приводит к значительному замедлению шага процедуры обучения.   
Для устранения указанного недостатка используются различные 
приближенные оценки 𝐻𝐻 по первой производной 𝐶𝐶(𝑥𝑥). Обобщенное 
название такого подхода — метод квази-Ньютона. 

Перепишем (1) в виде 𝐻𝐻𝑑𝑑𝑘𝑘 = 𝑦𝑦𝑘𝑘, где 𝑑𝑑𝑘𝑘 = 𝑥𝑥𝑘𝑘+1 − 𝑥𝑥𝑘𝑘 и 𝑦𝑦𝑘𝑘 = 𝑔𝑔𝑘𝑘+1 − 𝑔𝑔𝑘𝑘. To есть, 
имеем линейное отображение между изменением градиента и изменением 
позиции в пространстве ℝ𝑛𝑛 .  Представим теперь, что 𝐶𝐶(𝑥𝑥) не квадратичная и 
𝐵𝐵𝑘𝑘 — оценка 𝐻𝐻.  Тогда 𝐵𝐵𝑘𝑘+1 = 𝐵𝐵𝑘𝑘 + 𝛥𝛥𝛥𝛥. 

Следующее уравнение называется условием квази-Ньютона: 
𝐵𝐵𝑘𝑘+1𝑑𝑑𝑘𝑘 = 𝑦𝑦𝑘𝑘 

Правило прямого обновления 𝐻𝐻 представлено ниже: 
𝐵𝐵𝑘𝑘+1 = 𝐵𝐵𝑘𝑘 +

(𝑦𝑦𝑘𝑘 − 𝐵𝐵𝑘𝑘𝑑𝑑𝑘𝑘)(𝑦𝑦𝑘𝑘 − 𝐵𝐵𝑘𝑘𝑑𝑑𝑘𝑘)𝑇𝑇

(𝑦𝑦𝑘𝑘 − 𝐵𝐵𝑘𝑘𝑑𝑑𝑘𝑘)𝑇𝑇𝑑𝑑𝑘𝑘
ранг 1

𝐵𝐵𝑘𝑘+1 = 𝐵𝐵𝑘𝑘 +
𝑦𝑦𝑘𝑘  𝑦𝑦𝑘𝑘𝑇𝑇

𝑦𝑦𝑘𝑘𝑇𝑇𝑑𝑑𝑘𝑘
+

(𝐵𝐵𝑘𝑘𝑑𝑑𝑘𝑘)(𝐵𝐵𝑘𝑘𝑑𝑑𝑘𝑘)𝑇𝑇

(𝐵𝐵𝑘𝑘𝑑𝑑𝑘𝑘)𝑇𝑇𝑑𝑑𝑘𝑘
  ранг 2

 

Если представить условие квази-Ньютона в обратном виде 𝑑𝑑𝑘𝑘 = 𝑅𝑅𝑘𝑘+1𝑦𝑦𝑘𝑘, 
получим так называемое обратное обновление 𝐻𝐻: 

𝑅𝑅𝑘𝑘+1 = 𝑅𝑅𝑘𝑘 +
𝑑𝑑𝑘𝑘𝑑𝑑𝑘𝑘𝑇𝑇

𝑑𝑑𝑘𝑘𝑇𝑇𝑦𝑦𝑘𝑘
 +

𝑅𝑅𝑘𝑘𝑦𝑦𝑘𝑘𝑦𝑦𝑘𝑘𝑇𝑇𝑅𝑅𝑘𝑘
𝑦𝑦𝑘𝑘𝑇𝑇𝑅𝑅𝑘𝑘𝑦𝑦𝑘𝑘

 
Другой метод оптимизации без обновления матрицы 𝐻𝐻 называется 

методом сопряженного градиента (conjugate gradient).  Используется 
следующая схема: 

𝑥𝑥𝑘𝑘+1 = 𝑥𝑥𝑘𝑘 + 𝛼𝛼𝑘𝑘𝑢𝑢𝑘𝑘, 
где 𝑢𝑢𝑘𝑘 — направление поиска, определяемое по правилу: 

𝑢𝑢0  = −𝑔𝑔0
𝑢𝑢𝑘𝑘+1 = −𝑔𝑔𝑘𝑘+1 + 𝛽𝛽𝑘𝑘𝑢𝑢𝑘𝑘   

Способы расчета 𝛽𝛽𝑘𝑘 у разных авторов различаются: 
Флетчер − Ривз: 𝛽𝛽𝑘𝑘 =

𝑔𝑔𝑘𝑘+1𝑇𝑇 𝑔𝑔𝑘𝑘+1
𝑔𝑔𝑘𝑘𝑇𝑇𝑔𝑔𝑘𝑘

Полак − Рибир: 𝛽𝛽𝑘𝑘 =
𝑔𝑔𝑘𝑘+1𝑇𝑇 (𝑔𝑔𝑘𝑘+1 − 𝑔𝑔𝑘𝑘)

𝑔𝑔𝑘𝑘𝑇𝑇𝑔𝑔𝑘𝑘

 

Следует отметить, что моментуму в методе обратного 
распространения соответствуют коэффициенты 𝛼𝛼 и 𝛽𝛽 метода сопряженного 
градиента. 

Характерное свойство метода сопряженного градиента состоит в том, 
что текущее направление поиска перпендикулярно к градиенту в 
следующей точке: 

𝑢𝑢𝑘𝑘𝑇𝑇𝑔𝑔𝑘𝑘+1 = 0 
и направления поиска 𝑢𝑢_𝑘𝑘 и 𝑢𝑢𝑘𝑘+1 сопрягаются, учитывая 𝐻𝐻: 

𝑢𝑢𝑘𝑘𝑇𝑇𝐻𝐻𝑢𝑢𝑘𝑘+1 = 0 
Если функция стоимости 𝐶𝐶(𝑥𝑥) чисто квадратичная, метод 

сопряженного градиента сходится в 𝑛𝑛-мерном пространстве за 𝑛𝑛 шагов. В 
пространстве высокой размерности этот метод предпочтительней метода 
Ньютона.  
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Методы обучение без учителя  
Обучение без учителя требует знания только входных данных для 

нейронной сети. В процессе обучения нейронная сеть сама выявляет 
закономерности во входных данных и обучается эти закономерности 
воспроизводить на выходе. В живой природе аналогом данного подхода к 
обучению является, например, способность человеческого интеллекта к 
обобщению и выявлению схожих черт в вещах и явлениях. Недостатками 
обучения без учителя является непредсказуемость выхода нейросети и 
неуверенность в актуальности для всего множества входных данных 
закономерностей, полученных на обучающей выборке. Для 
идентификации результата работы нейросети как правило требуется 
дополнительный распознающий блок. 

Наиболее известным методом обучения в рамках данного подхода 
является конкурентное обучение. 

Обучение без учителя используется для обучения 
самоорганизующихся нейронных сетей. Наиболее известными среди них 
являются сети Кохонена [], разработанные в 80-х годах финским ученым.  

В 1976 г. С. Гроссбергом был предложен и затем развит в работах Т. 
Кохонена метод обучения без учителя названный конкурентным методом 
обучения. Нейронные сети, использующие такой метод обучения, 
называются конкурентными.  

Суть конкурентного метода обучения рассмотрим на примере 
конкурентной сети изображенной на рис . Первый слой этой сети 
выполняет распределительные функции, причем каждый нейрон имеет 
соединения со всеми нейронными элементами выходного слоя. Второй 
слой (слой нейронов Кохонена) при подаче на вход сети определенного 
образа осуществляет конкуренцию между нейронными элементами, в 
результате которой определяется нейрон-победитель, имеющий 
максимальную взвешенную активность (правило известно под названием 
«победитель берет все»): 

∑ ==
i

T
jiijj XWxwS  ,      (8)  

где Х = {х1, х2,...,хn} — входной образ, Wj = {w1j, w2j, …, wnj} — вектор 
столбец весовых коэффициентов j-го выходного нейрона. 
Пусть jjk SS max= , тогда активность выходных нейронов  





≠
=

==
,,0
;,1

)(
kjесли
kjесли

SFy jj       (9) 

где mj ,1= . 
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В процессе обучения для нейрона-победителя синаптические связи 
усиливаются, а для остальных нейронов не изменяются или могут 
уменьшаться. 
Выражение (8) эквивалентно скалярному произведению вектора весов 
соответствующего нейронного элемента на входной вектор нейронной 
сети:  

αcos|||| ⋅⋅= XWS jj  ,      (10) 

где α - угол между векторами Wj и X.  
Отметим, что для адекватного определения нейрона-победителя вектора 
Wj и X должны быть нормированы, тогда αα coscos|||| =⋅⋅= XWS jj  и 
максимальную активность будет иметь тот нейрон, весовой вектор 
которого коллинеарен входному вектору. Концы векторов при этом 
находятся на поверхности n-мерной сферы, радиус которой равен единице. 
В этом случае правило настройки весовых коэффициентов нейрона-
победителя должно соответствовать вращению вектора Wk в сторону 
вектора Х (рис.7). 

 
Рисунок 7: Модификация весового вектора нейрона победителя 

В результате можно записать следующее правило обучения для 
вектора весов k-го нейрона-победителя: 

))(()()1( tWXtWtW kkk −+=+ γ   или ))(()()1( twxtwtw ikiikik −+=+ γ  (11) 
, где 10 << γ  характеризует скорость обучения; ni ,1=  

С учетом нормировки правило обучения записывается в следующем виде: 

|))()(()(|
))()(()()1(

tWtXtW
tWtXtWtW

kk

kk
k −+

−+
=+

γ
γ  или 

|))()(()(|
))()(()()1(

tWtXtW
twtxtwtw

kk

ikiik
ik −+

−+
=+

γ
γ  

В случае использования ненормализованных векторов для 
определения нейрона-победителя нужно оперировать вместо взвешенной 
активности (6) евклидовым расстоянием  

22
22

2
11 )(...)()(|| njnjjjj wxwxwxWXD −++−+−=−=   (12) 
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При помощи (10) определяется нейрон-победитель с номером k, 
соответствующий минимальному евклидовому расстоянию между 
входным и весовым векторами: 

||min jjk WXD −=         (13) 

Тогда настройка весового вектора нейрона-победителя происходит 
следующим образом: 

))()(()()1( tWtXtWtW kkk −+=+ γ       (14) 

Недостатком этого метода обучения является то, что при случайной 
инициализации весовых векторов может получиться так, что некоторые 
нейроны никогда не будут победителями. Для нейтрализации этого 
недостатка можно расширить правило обучения следующим образом []: 

kjtWXtWtW jjj =∀−+=+ )),(()()1( γ , 

kjtWXtWtW jjj ≠∀−′+=+ )),(()()1( γ , 

где γγ <<′  

Данное правило позволяет отобразить весовые векторы побежденных 
нейронов в область, где увеличиваются их шансы в конкуренции.  

Объединение различного рода нейронных сетей и концепций их 
обучения привело к появлению гибридных нейронных сетей. Так, 
дальнейшим расширением нейронных сетей Кохонена являются сети 
встречного распространения сигналов (рис.), предназначенные для 
аппроксимации функций. Эти сети характеризуются сочетанием двух 
подходов к обучению: с учителем и без учителя. В свою очередь развитием 
сетей встречного распространения стали нейронные сети с радиально-
базисной функцией активации, применяющиеся для решения задач 
распознавания образов, прогнозирования, сжатия данных и аппроксимации 
функций. 

Рекомендации по литературе 
Для изучения архитектуры различных нейронных сетей, методов их 

обучения и областей применения в рамках учебного курса рекомендуются 
книги [4–7].  Для глубокого ознакомления с теорией нейронных сетей 
рекомендуются книги [8–9].  Расширенное представление о способах 
применения нейронных сетей для решения задач управления можно 
получить в книге [10]. 

Нейросетевой пакет NNACS представлен в статьях [11–12].  Доступ к 
исходным текстам и двоичным сборкам представлен по ссылкам [13–14]. 
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Лабораторная работа № 1 
 

Изучение основных понятий теории ИНС и приемов работы с 
пакетом Statistica Neural Networks 

 
Цель работы: освоение приемов работы с программным пакетом Statistica 
Neural Networks и изучение основных понятий теории ИНС на примере 
простых задач распознавания логических функций (И, ИЛИ, исключающее 
ИЛИ). 
 
Задание 

1. Ознакомиться с интерфейсом и функциональными возможностями 
программы Statistica Neural Networks. (Пункты меню File, Edit, 
Statistics, Run). 

2. Задать исходные данные для решения задачи распознавания 
логической функции AND. Для этого выбрать пункт меню File->New 
Data Set…, указать количество входов (Inputs) равное двум, 
количество выходов(Outputs) равное единице. В открывшемся окне 
(Data Set Editor) ввести данные из таблицы 

X Y X AND Y 
0 0 0 
1 1 1 
0 1 0 
1 0 0 

Сохранить исходные данные в файле «AND_data.sta»  (File->Save 
as…). 
3. Построить нейросеть (НС) для решения задачи из п.2.. Открыть окно 

Create Network (File->New Network…), указать тип нейронной сети 
Multilayer Perceptron, количество слоев 2 (No Layers), число входов 
(Inputs) равное двум, число выходов (Outputs) равное единице, 
остальные параметры оставить без изменения (Steps = 1, Lookahed = 
0). Убедиться в том, что для всех нейронов установлена функция 
преобразования Minimax и создать НС нажатием кнопки Create. 
Изучить возможности изменения параметров созданной НС (Edit-

>Network…). 
4. Обучить НС. Вызвать окно отображения ошибки обучения (Statistics-

>Training Graph…). Открыть окно с параметрами обучения 
Алгоритма обратного распространения ошибки (Train->Multilayer 
Perceptrons->Back Propagation…). 
Добиться приемлемо низкой ошибки обучения, задавая различные 
параметры обучения (количество эпох, шаг обучения, …). Ошибки 
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тестирования нейронной сети можно посмотреть, воспользовавшись 
пунктом меню Run->Data Set…. 
При невозможности качественно обучить НС следует изменить 
структуру НС (количество слоев, количество нейронов в слоях, 
функции активации нейронов). 

5. Решить задачи распознавания логических функций (OR, XOR). 
Исследовать решение этих задач при задании различных функций 
активации нейронов обрабатывающих слоев (линейная, пороговая, 
сигмоидная (логистическая)).  

 
Контрольные вопросы к лабораторной работе №1 

1. Дайте определение понятия “формальный искусственный нейрон” и 
поясните его назначение.  

2. Приведите классификацию нейронных сетей и примеры их 
применения. 

3. Какие функции активации вам известны? Расскажите, в каких 
случаях следует применять ту или иную функцию. 

4. С помощью какого алгоритма обучается нейронная сеть при 
решении задачи распознавания логических функций? Расскажите 
про этапы создания, обучения и проверки работоспособности 
нейронной сети. 

5. Что такое шаг обучения? Как он влияет на получение конечного 
результата. 

6. Что такое ошибка обучения ИНС? 
7. В чем сходство процедуры обучения ИНС и человека и в чем 

различие? 
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Лабораторная работа № 2 
 

Многослойный персептрон. 
 

Цель работы: изучение алгоритмов обучения многослойного персептрона, 
выбор структуры и контроль качества обучения ИНС, решение задачи 
классификации многомерных данных. 
 
Задание 

1. Открыть хранящиеся в файле min_water.txt данные о сорока образцах 
минеральной воды. Проведя предварительный анализ данных, 
выделить из 23-х признаков наиболее информативные для 
классификации образцов признаки. Разделить имеющуюся выборку 
на три части: для обучения, для верификации, для тестирования. 
Сохранить исходные данные. 

2. Создать многослойный персептрон с одним нейроном в выходном 
слое. Решить задачу классификации имеющихся данных об образцах 
минеральной воды по пяти классам, используя при обучении 
алгоритм обратного распространения ошибки. Проанализировать, 
полученные результаты. 

3. Создать многослойный персептрон с пятью нейронами в выходном 
слое и снова решить задачу классификации имеющихся данных об 
образцах минеральной воды по пяти классам. Проанализировать, 
полученные результаты. По результатам п.2 и п.3. выбрать 
наилучшую структуру ИНС для решения поставленной задачи. 

4. Решить задачу классификации образцов минеральной воды с 
помощью любого другого алгоритма обучения. 

5.  Решить задачу классификации образцов минеральной воды по 
четырем классам, предварительно пометив один из классов, как 
недоступный в процессе обучения. Проанализировать результаты 
классификации, предъявив обученной ИНС неизвестный сорт 
минеральной воды. Объяснить полученные результаты. 
 

Контрольные вопросы к лабораторной работе №2 
1. Что такое многослойный персептрон? К какому классу ИНС он 

относится? Какие практические задачи позволяет решать? 
2. Как выбирается архитектура ИНС при решении задачи классификации? 
3. Какие алгоритмы обучения предназначены для обучения 

многослойного персептрона? Приведите их достоинства и недостатки. 
4. Объясните принцип алгоритма обратного распространения ошибки. 
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5. Что такое эффект переобучения ИНС? Как проконтролировать его 
возникновение? 

6. Каково назначение моментного параметра в алгоритме обратного 
распространения ошибки? 

7. Как оценивается качество обучения и работы ИНС? Как рассчитывается 
ошибка обучения? 
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Лабораторная работа № 3 
 

Применение многослойного персептрона. Автоассоциативная 
ИНС. 

 
Цель работы: знакомство с применением многослойного персептрона для 
решения задач сжатия данных, прогнозирования временных рядов и 
распознавания образов. 
 
Задание 

1. Открыть файл с данными по минеральной воде, который 
использовался при решении задач классификации в предыдущей 
лабораторной работе. Построить и обучить автоассоциативные 
нейронные сети с 2-я и 3-я нейронами в скрытом слое: 

а). для исходных данных из 5-ти классов; 
б). для исходных данных из 4-х классов. 

Провести визуализацию данных в скрытом слое каждой сети на 
плоскость и в 3-х мерное пространство. Проанализировать 
полученные результаты. Выбрать и сохранить автоассоциативные 
ИНС, обеспечивающие наилучшее сжатие исходных данных  

2. Исследовать возможности ИНС по прогнозированию поведения 
нелинейных динамических систем (построение странного 
аттрактора) на примере отображения Хенона. Аттрактор Хенона 
может быть получен из уравнений: 

nnn yxx +−=+
2

1 1 α  
nn xy β=+1  

3.04.1 == βα  
Решение данных уравнений представлено в файле NK4_Xenon.sta. 
Для прогнозирования предлагается использовать многослойный 
персептрон (МП) и сеть с радиально базисными функциями. 
Например, для прогнозирования координаты X на один шаг вперед 
можно создать МП с 7 нейронами во входном слое, 5-тью нейронами 
в скрытом слое и 1 нейроном в выходном. (File->New->Network, 
Steps = 7, Lookahead = 1, Layer2 = 5, Create). При этом в исходных 
данных координату X необходимо пометить как Input/Output, а 
координату Y как Ignore. В качестве функций активации в выходном 
слое предлагается использовать логистическую функцию или  
линейную. Сеть можно обучить с помощью алгоритма обратного 
распространения ошибки или алгоритма Levenberg-Marquardt-а. 
После обучения для оценки результатов прогнозирования 
воспользоваться пунктом меню Run->Time Series…. 
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Проанализировав полученные результаты, постройте прогноз курса 
доллара на 1-2 дня вперед. В качестве исходных данных можно 
использовать курс доллара за несколько лет из файла USD.sta или 
загрузить актуальные данные с сайта центрального банка России 
(http://www.cbr.ru). 

3. Решить задачу распознавания 9-ти изображений самолетов. 
Исходные данные (файлы avia1.bmp, …, avia9.bmp) необходимо 
предварительно преобразовать в набор векторов со значениями 
признаков 0 или 1. Обученная нейронная сеть должна правильно 
определять модель самолета и его класс 
(истребитель/бомбардировщик). Принадлежность модели к 
определенному классу выбирается студентом самостоятельно. 

 
Контрольные вопросы к лабораторной работе №3 

1. Какая ИНС называется автоассоциативной? В чем особенности её 
обучения? 

2. Как оценивается степень сжатия данных при использовании 
автоассоциативной ИНС?  

3. Аналогом какого классического метода снижения размерности 
может считаться снижение размерности с помощью 
автоассоциативная ИНС и при каких параметрах обучения? 

4. С помощью каких ИНС можно решать задачи прогнозирования? 
5. Зависит ли результат прогноза от вида используемой ИНС 

(гомогенная/гетерогенная сеть)? 
6. Можно ли использовать для прогнозирования и сжатия данных сеть 

с радиально-базисными функциями? 
7. Какие ИНС могут использоваться в задачах распознавания образов? 

http://www.cbr.ru/
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Лабораторная работа № 4 
 

Сеть Кохонена 
 

Цель работы: знакомство с алгоритмом обучения ИНС без учителя, 
изучение сети Кохонена на примере задачи кластеризации данных. 
 
Задание 

1. Изучить разделы справки связанные с обучением сети Кохонена. 
Открыть файл исходных данных Iris.sta, содержащий измерения 
длины и ширины чашелистика и лепестка 150 экземпляров ириса. 
Создать сеть Кохонена и выполнить с помощью неё кластеризацию 
сортов ириса. Проанализировать полученные результаты. Выполнить 
визуализацию исходных данных. 

2. Построить и обучить сеть Кохонена для кластеризации данных 
скрытого слоя автоассоциативной сети из п.1. лабораторной работы 
№3. Проанализировать результаты и сравнить их с результатами 
классификации многослойным персептроном, полученными в 
лабораторной работе №2. 

 

Контрольные вопросы к лабораторной работе №4 
1. Какова структура сети Кохонена? Для решения каких задач 

предназначена эта сеть? С помощью какого алгоритма обучается? 
2. Объясните принцип алгоритма обучения без учителя. Каков 

критерий останова процедуры обучения сети Кохонена? 
3. Как инициализируются весовые коэффициенты сети перед началом 

обучения? Зачем нужна нормировка входных векторов и весовых 
коэффициентов? 

4. Объясните, с помощью какого алгоритма в Statistica Neural Networks 
осуществляется присвоение меток кластеров нейронам сети 
Кохонена? 

5. Пояснить, можно ли использовать сеть Кохонена для сжатия 
данных? 

6. Что общего у сетей Кохонена и многослойного персептрона и чем 
они отличаются? 

7. Какой результат можно ожидать при обучении сети Кохонена при 
количестве выходных нейронов, меньшем (большем) числа 
обучаемых классов? 
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Лабораторная работа № 5 
 

Синтез нейросетевого оптимального регулятора 
 

Цель работы  Лабораторная работа посвящена задаче синтеза 
нейросетевого оптимального регулятора (НОР).  В ней изучаются 
принципы применения нейронных сетей в качестве регулятора и модели 
объекта управления.  Исследуется влияние архитектуры нейронной сети на 
скорость и качество обучения. Полученный НОР используется в 
последующих лабораторных работах. 
Задание Имеется система управления с обратной связью.  У объекта 
управления один управляющий вход и один наблюдаемый выход.  
Известно, что в канале наблюдения имеется случайная помеха. Дана 
стохастическая модель сигнала уставки. Необходимо заменить регулятор 
на нейросетевой с минимизацией квадрата ошибки управления. 
Для простоты понимания задачи и в целях последующего сравнения с 
линейными регуляторами в качестве объекта управления и регулятора 
берутся линейные звенья, хотя методика синтеза никак не ограничивает в 
выборе класса управляемого объекта и заменяемого регулятора. 
В процессе выполнения промежуточных этапов синтеза исследуется 
влияние архитектуры нейронной сети (количество слоев, распределение 
нейронов в них) на скорость обучения и достигаемое качество. 

Необходимо последовательно выполнить следующие этапы: 
1. Моделирование САУ с линейным регулятором в контуре и со 

ступенчатой уставкой (меандр) в качестве уставки с целью 
удостовериться в устойчивости контура и управляемости объекта.  При 
необходимости надо изменить параметры регулятора. 

2. Моделирование САУ с линейным регулятором в контуре, со 
стохастической уставкой и случайной помехой с целью сбора данных 
для обучения.  Следует провести два разных сеанса получением двух 
независимых выборок: обучающей и контрольной. 

3. Обучение нейросетевого регулятора вне контура управления подобно 
исходному линейному регулятору.  При этом следует создать 
нейронную сеть регулятора и указать файлы данных для обучения: 
обучающую и контрольную выборки.  Для получения лучшего 
результата провести эксперименты с различными архитектурами 
нейронных сетей. 

4. Моделирование САУ с нейросетевым регулятором, обученным вне 
контура.  На вход подается стохастическая выборка, оценивается 
качество управления. 
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5. Обучение нейросетевой модели объекта вне контура управления.  При 
этом следует создать нейронную сеть модели объекта и указать файлы 
данных для обучения: обучающую и контрольную выборки.  Для 
получения лучшего результата провести эксперименты с различными 
архитектурами нейронных сетей и наборами входов. 

6. Обучение нейросетевого оптимального регулятора в контуре 
управления.  В качестве начального приближения берется нейросетевой 
регулятор, обученный вне контура управления.  Задействуется также 
предварительно настроенная нейросетевая модель объекта управления.  
Обучение проводится на стохастической выборке уставки и помехи. 

7. Моделирование САУ с нейросетевым оптимальным регулятором, 
обученным в контуре.  На вход подается стохастическая выборка, 
оценивается качество управления. 

Отчет должен включать следующие элементы: 
− Описание исходной системы управления. 
− Архитерктура нейросети регулятора (НС-Р).  Перечень опробованных 

вариантов архитектур. 
− Характеристики обучающей и контрольной выборок: формирующий 

фильтр, длина, минимальная и максимальная амплитуды сигналов в 
выборках. 

− Процесс обучения нейросетевого регулятора: графики ошибки, 
длительность и результат обучения. Выбор одного из вариантов 
архитектуры НС-Р 

− Проверка нейросетевого регулятора в контуре, сравнение с исходным 
линейным. 

− Численная оценка качества управления нейросетевым регулятором, 
обученным вне контура (СКО, максимальное перерегулирование). 

− Архитерктура нейросети модели объекта (НС-О). 
− Характеристики обучающей и контрольной выборок: формирующий 

фильтр, длина, минимальная и максимальная амплитуды сигналов в 
выборках. 

− Процесс обучения нейросетевой модели объекта: графики ошибки, 
длительность и результат обучения.  Выбор одного из вариантов 
архитектуры НС-О. 

− Процесс обучения нейросетевого оптимального регулятора в контуре 
управления.  Параметры обучения.  Графики ошибок управления и 
идентификации. 

− Сравнение качества управления (СКО, максимальное 
перерегулирование) для исходного регулятора, НС-Р, обученного вне 
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контура, нейросетевого оптимального регуляторов (на одной и той же 
выборке).  Графики уставки и её отработки объектом. 

Выводы должны содержать перечисление факторов, оказывающих 
влияние на процесс обучения нейросети вне и в контуре управления. 
 

Контрольные вопросы к лабораторной работе №5 
1. Что такое Eta и почему значение этого параметра меняется в 

процессе обучения НС-Р? 
2. Почему для настройки нейросетевого регулятора и нейросетевой 

модели объекта вне контура управления используются 
стохастические сигналы? 

3. Для чего используется нейросетевая модель объекта управления? 
4. Какие параметры управляют процессом обучения НОР в контуре и 

каков их смысл? 
5. Чем отличается обучение нейросетевого регулятора в контуре 

управления и вне его? 
6. Можно ли использовать сигмоидальную функцию активации в 

последнем слое нейросетевой модели объекта? 
7. Чем должен отличаться НОР от нейросетевого регулятора, 

обученного вне контура управления? 
8. Можно ли использовать сигмоидальную функцию активации 

выходного нейрона нейросетевого регулятора? 
9. Какие критерии используются для останова процедуры обучения 

нейросетевого регулятора вне контура управления? 
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Лабораторная работа № 6 
 

Сравнительное исследование нейросетевого оптимального и 
ПИД регуляторов 

 
Цель работы Работа посвящена исследованию свойств нейросетевого 
оптимального регулятора в сравнении с линейным регулятором типа 
ПИ/ПИД. Сравнение регуляторов проводится в различных условиях на 
основе интегрального (среднеквадратическая ошибка) и экстремального 
(максимальная ошибка) критериев. 

Задание Имеется система управления с обратной связью и линейным 
объектом управления.  Стохастические параметры уставки и помехи 
заданы. Для системы синтезированы ПИ/ПИД регулятор и нейросетевой 
оптимальный регулятор (НОР), например, полученный во время первой 
лабораторной работы. Сравнение регуляторов следует проводить исходя из 
достигнутого ими качества управления на достаточно длинном временном 
интервале. Критериями качества управления являются максимальное по 
модулю перерегулирование и среднеквадратическая ошибка. 

Требуется экспериментально исследовать поведение регуляторов в 
номинальных условиях (формирующие фильтры уставки и помехи 
совпадают с использовавшимися при синтезе нейросетевого оптимального 
регулятора, объект управления тот же самый), на разных видах сигнала 
уставки (ступенчатом, гармоническом, стохастическом), а также в 
условиях, отличных от номинальных: иные параметры объекта 
управления, уставки и помехи (отсутствие, номинальный уровень, 
повышенный уровень помехи, “цветная” помеха). Экспериментально 
определить зависимость качества управления от частоты, подавая на вход 
системы гармоническую уставку. 

Варианты Данная работа проводится по тем же вариантам параметров 
объекта управления и регулятора, как и лабораторная работа №5. 
Параметры линейного регулятора допускается произвольно изменять 
(например, подобрав их более оптимально, чем это сделано в таблице 
вариантов). 

План работы Каждый пункт плана работы подразумевает независимый от 
других пунктов сеанс моделирования для каждого из двух регуляторов. 
Перед этим необходимо подготовить сигналы уставки и помехи, а также 
установить параметры объекта управления сообразно заданию. 
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Перечень экспериментов: 

1. Номинальная стохастическая уставка и помеха, номинальный объект 
управления. 

2. Уставка — меандр с амплитудой 1 и длительностью ступеней 50 
(достаточной для завершения переходного процесса). Помеха — 
отсутствует.  Объект управления — номинальный. 

3. Стохастическая уставка, отличная от номинальной с дисперсией, 
примерно совпадающей с номинальной. Номинальная помеха. Объект 
управления — номинальный. 

4. Стохастическая уставка, отличная от номинальной с дисперсией, 
превышающей номинальную (взять больший коэффициент усиления). 
Номинальная помеха. Объект управления — номинальный. 

5. Номинальная стохастическая уставка.  Помеха — белый шум с 
интенсивностью в два раза больше, чем номинальная. Объект 
управления — номинальный. 

6. Номинальная стохастическая уставка. Помеха — “цветной” шум 
небольшой интенсивности.  Объект управления — номинальный. 

7. Номинальная стохастическая уставка и помеха. Параметры объекта 
управления отличаются от номинальных (изменить коэффициент 
усиления и/или константы времени). 

8. Уставка — синусоида с амплитудой 1.  Помеха — отсутствует.  Объект 
управления — номинальный.  Повторить для нескольких различных 
периодов уставки (4, 6, 8, 10, 16, 20, 40). 

Отчет должен включать описание объектов управления, параметры 
ПИ/ПИД регулятора, архитектуру НОР и номинальные условия его 
обучения (формирующие фильтры уставки и помехи, а также их диапазон 
амплитуд в процессе обучения). 

По результатам экспериментов должна быть составлена таблица 
следующего формата: 

№ Объек
т 

Уставка Помеха Длин
а 

ПИ/ПИД НОР 
Ви
д 

|A|ma
x 

Ви
д 

|A|ma
x 

СК
О 

|e|ma
x 

СК
О 

|e|ma
x 

           
 
Примечания: 
− Для объекта в таблице указывается: ном. – номинальные параметры и 

изм. – параметры изменены. 
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− Для уставки и помехи вид: ном. – номинальные (как при синтезе НОР), 
изм. – стохастические, отличные от номинальных, меандр – 
знакопеременная ступенька, гарм,(T) - синусоида с указанным 
периодом, конст. – постоянное значение. 

− |A|max – максимальная ампитуда. 
− Длина – длительность выборки в отсчетах. 
− СКО – среднеквадратическая ошибка управления (MSE в терминах 

программы). 
− |e|max – максимальное перерегулирование. 

Также должны быть представлены графики зависимости СКО и |e|max от 
частоты (для гармонической уставки) и графически проиллюстрированы 
результаты управления в экспериментах 2, 4, 7. 

Выводы должны на основании приведенных в таблице результатов 
экспериментов содержать перечисление факторов, оказывающих влияние 
на качество регулирования линейным и нейросетевым оптимальным 
регуляторами.  Перечислить и аргументировать отличия нейросетевого 
регулятора от линейного. 

Контрольные вопросы к лабораторной работе №6 
1. Быстродействие какого регулятора выше: ПИД или НОР?  Покажите 

на графиках. 
2. Какой регулятор и почему лучше справляется со ступенчатой 

уставкой (меандр) в смысле минимума СКО? 
3. Почему на гармонической уставке малой частоты ПИ/ПИД лучше 

НОР? 
4. Что нужно сделать, чтобы нейросетевой регулятор лучше 

отрабатывал отрицательную часть гармонической уставки? 
5. Какой из регуляторов более робастный (менее чувствительный к 

выбранному изменению параметров объекта)? 
6. Можно ли построить частотные характеристики для НОР? 
7. На каких видах уставок нейросетевой регулятор очевидно хуже 

ПИД? 
8. Почему у нейросетевого регулятора два входа: уставка и ошибка 

управления? 
9. Предположите, смог бы нейросетевой регулятор с единственным 

входом – ошибкой управления – использоваться в качестве 
нейросетевой имитации ПИД регулятора? 
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Лабораторная работа № 7 
 

Нейросетевая модель объекта управления 
 

Цель работы  – изучение влияния архитектуры нейросетевой модели 
объекта управления и пробных сигналов, используемых для её обучения, 
на настройку нейросетевого оптимального регулятора в контуре 
управления. 

Задание Дана система управления с традиционным регулятором.  
Считаем, что архитектура нейросетевого регулятора уже выбрана и он 
обучен вне контура управления.  Для дальнейшего обучения этого 
регулятора в контуре необходимо построить нейросетевую модель объекта 
управления.  Архитектура этой нейронной сети определяется следующими 
параметрами: 

− Количество входов с задержанным сигналом управляющего 
воздействия uk, uk-1, … 

− Количество входов с задержанным сигналом наблюденного выхода 
объекта (с помехой) yk-1, yk-2, … 

− Количество слоев и распределение нейронов в них. 
− Функция активации нейрона выходного слоя. 

Данная нейронная сеть не имеет обратных связей и реализует имитацию 
динамики объекта управления за счет задержанных входных сигналов.  
Нейронная сеть настраивается на данных, полученных в результате 
наблюдения за функционированием исходной системы управления (с 
традиционным регулятором) при подаче в качестве уставки некоторого 
пробного сигнала.  Таким образом, обучающая и контрольная выборка 
формируются вследствие влияния пробного сигнала уставки на систему 
управления.  Вид обучающих данных наряду с архитектурой оказывает 
влияние на обучение нейронной сети и на качество её рабочего 
функционирования. 

Особенность рабочего функционирования НС-О заключается в том, что 
распространение сигнала в прямом направлении (от входа к выходу), 
является вспомогательным, хотя и позволяет оценить собственно качество 
имитации.  Основным является обратное распространение ошибки 
управления через НС-О в направлении от выхода к входам, базирующееся 
на предварительно вычисленной при прямом распространении степени 
активности нейронов.  Приведение ошибки управления к входу uk 
нейросетевой модели эквивалентно расчету оценки якобиана объекта (при 
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условии достаточно точной имитации объекта моделью).  Оценить 
точность расчета якобиана можно косвенно, по эффективности обучения 
нейросетевого оптимального регулятора в контуре.  Если якобиан 
рассчитывается недостаточно точно, то обучение НОР не будет приводить 
к уменьшению ошибки управления, наоборот, возможно ухудшение 
качества управления. 

В рамках лабораторной работы необходимо исследовать влияние 
параметров нейросети и обучающих выборок от разных пробных сигналов 
на точность оценки якобиана объекта управления. 

План работы 
1. Задать в качестве уставки в исходной системе управления сигналы 

разного вида: стохастический, гармонический и меандр 
(ступенчатый) в диапазоне рабочих значений.  Помеха должна быть 
стохастической небольшой мощности.  Провести соответствующие 
сеансы моделирования и получить выборки u, y для обучения. 

2. Контрольную выборку необходимо получить в отдельном сеансе 
моделирования со стохастической уставкой. 

3. Выбрать пять архитектур НС-О, различающихся по количеству слоев 
с нейронами (обязательно с 0, 1 и 2 скрытыми слоями) и по 
количеству входов. 

4. Провести обучение каждой из архитектур НС-О на обучающих 
данных с разными пробными сигналами.  Зафиксировать, какая 
архитектура при каком пробном сигнале обучается лучше всего, то 
есть, имеет в результате обучения вне контура наименьшую ошибку 
на контрольной выборке.  Итого: 15 сеансов обучения и 5 нейросетей 
– победителей. 

5. Создать достаточно длинную выборку стохастической уставки и 
помехи в рабочих диапазонах значений (L=105). 

6. Провести сеансы дообучения нейросетевого оптимального 
регулятора в контуре на заданных в п.5 входных выборках с одного и 
того же исходного НС-Р, но с различающимися НС-О. Итого: 5 
сеансов.  Оценить качество имитации объекта нейросетевой 
моделью. 

Отчет должен включать следующие элементы: 
− Описание исходной системы управления. 
− Перечень опробованных вариантов архитектур нейросети модели 

объекта (НС-О). 
− Перечень с описанием и графики пробных сигналов, использовавшихся 

для сбора обучающих данных. 
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− Графики обучения НС-О вне контура для различных пробных сигналов 
и архитектур НС-О. 

− Таблица с достигнутыми числовыми оценками качества имитации 
объекта управления вне контура (на разных пробных сигналах) и в 
контуре (среднеквадратические ошибки выхода объекта и модели). 

− Графики уставки и выхода объекта в диапазонах: начальном, 
интенсивной подстройки весовых коэффициентов НОР в процессе 
дообучения и в конце времени моделирования (либо перед потерей 
устойчивости в контуре). 

− Таблица среднеквадратических ошибок управления в начале и в конце 
времени моделирования для каждой из архитектур НС-О. 

Выводы должны содержать формулировку обнаруженных зависимостей 
точности оценки якобиана и аргументированный выбор наилучшей с точки 
зрения обучения НОР в контуре комбинации пробного сигнала и 
архитектуры НС-О. 
 

Контрольные вопросы к лабораторной работе №7 
1. Какие входы и выходы у нейросетевой модели объекта? 
2. Для чего на вход нейросетевой модели подают задержанные сигналы 

управляющего воздействия и выхода объекта? 
3. Каковы параметры обучения нейросетевой модели объекта? 
4. Как алгоритм обратного распространения используется при 

обучении НОР? 
5. Можно ли использовать при моделировании объекта выход 

нейросетевой модели, а не объекта? 
6. Является ли среднеквадратическая ошибка обучения нейросетевой 

модели вне контура однозначной характеристикой её применимости 
для дообучения нейросетевого оптимального регулятора? 

7. Как влияет структура сети (количество слоев и нейронов в них) на 
успех обучения нейросетевой модели и её использования для синтеза 
НОР? 

8. Что можно сказать об устойчивости процесса дообучения НОР в 
контуре?  Как устойчивость связана с качеством нейросетевой 
имитации объекта? 

9. Почему необходим этап предварительного обучения НС-Р вне 
контура управления? 
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Лабораторная работа № 8 
 

Нейросетевая система управления нестационарным объектом 
 

Цель работы В работе изучается применение нейросетевой модели 
объекта совместно с алгоритмом кумулятивных сумм для обнаружения 
изменения параметров объекта управления. 

Задание Имеется система управления с обратной связью и линейным 
объектом управления.  Стохастические параметры уставки и помехи 
заданы. Для системы синтезированы ПИ/ПИД регулятор, нейросетевой 
оптимальный регулятор (НОР) и нейросетевая модель объекта управления, 
например, полученные во время первой лабораторной работы. Будем 
считать, что объект управления в какой-то момент времени меняется свои 
свойства.  Это моделируется тем, что переходная функция объекта с этого 
момента задается другим уравнением с другими параметрами.  
Своевременное обнаружение момента изменения свойств объекта 
позволяет провести перенастройку регулятора и восстановить качество 
управления. 

Изменение параметров объекта управления приводит к изменению 
статистических параметров сигналов в контуре, в частности, изменяются 
дисперсии 2σ  ошибки управления ie и идентификации id .  Данный процесс 
называется разладкой.  Для её обнаружения разработан алгоритм 
кумулятивных сумм (АКС), основанный на статистически надежном 
определении факта изменения параметра наблюдаемого сигнала, 
например, дисперсии ошибки идентификации, от исходного значения 2

0σ  к 
некоторому априорно заданному 2

1σ , свидетельствующему о так 
называемой номинальной разладке.  При функционировании АКС в 
каждый момент времени i вычисляется значение изображающей точки iS  
(в пакете программ обозначается ip – imaging point): 
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Критерием обнаружения разладки является достижение изображающей 
точкой некоторого априорно заданного порога H, называемого решающей 
границей: 
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HSi >  

Факт достижения изображающей точкой решающей границы 
свидетельствует о разладке в вероятностном смысле.  Для надежности 
следует продолжать процедуру АКС и если в течение короткого времени 
решающая граница снова будет достигнута, вероятность установления 
факта разладки будет гораздо выше.  Если задать слишком низкий порог H, 
то возможны ложные тревоги.  Если порог H очень высокий, факт разладки 
будет определен с опозданием, что в реальной системе управления 
приведет к длительной неоптимальности управления. 

В лабораторной работе требуется подобрать параметры АКС для 
безошибочного и быстрого обнаружения разладки по дисперсии ошибки 
идентификации: 2

0σ , 2
1σ , H. Для безошибочного и быстрого обнаружения 

разладки.  Эксперименты следует проводить при случайном цветном 
сигнале уставки и случайной помехе. 

Варианты Данная работа проводится по тем же вариантам параметров 
объекта управления и регулятора, как и лабораторная работа №1.  Объект 
управления следует изменить незначительно с тем, чтобы контур не 
потерял устойчивости как под управлением линейного регулятора, так и 
под управлением нейросетевого. 

План работы Для проведения работы следует вызвать пункт главного 
меню, посвященный обнаружению разладки в контуре управления.  При 
задании параметров объекта, неизменных во времени, можно 
воспользоваться файлами с расширением .tf, но для задания объекта, 
меняющего параметры в процессе моделирования, надо задать имя файла с 
расширением .cof.  Редактирование такого объекта позволит задавать 
разные переходные функции в разные диапазоны времени.  При задании 
диапазона 1−  имеет смысл ∞+ .  Таким образом, нестационарный объект, 
меняющий коэффициент усиления в 250=t , описывается таблицей: 

Имя 
функции 

Формула и 
параметры 

От До 

Function1 
8.0
5.02.0

−
−

z
z  0 249 

Function2 
8.0
5.03.0

−
−

z
z  250 -1 

Последовательность действий: 
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1. Задать параметры исходного объекта, нейросетевую модель объекта 
управления и исходный линейный регулятор.  Длительность 
моделирования – 2000 отсчетов.  Определить исходную дисперсию 
ошибки идентификации 2

0σ . 
2. Выбрать задать другие параметры исходного объекта, при которых 

контур сохраняет устойчивость.  Длительность моделирования – 
2000 отсчетов.  Определить дисперсию ошибки идентификации при 
номинальной разладке 2

1σ . 
3. Задать нестационарный объект управления с изменением параметров 

в момент времени 1000=t .  Параметры объекта должны отличаться 
от заданных в п.2.  В параметрах АКС задать дисперсии 2

0σ , 2
1σ , 

интервал второго обнаружения должен быть равен -1.  В ряде 
экспериментов подобрать значение решающей границы, 
обеспечивающее безошибочное и быстрое обнаружение разладки. 

4. Задать положительный интервал второго обнаружения разладки.  
Моделирование будет останавливаться, если разладка будет 
обнаружиться дважды в пределах временного интервала данной 
длительности. 

Провести несколько экспериментов, убедившись в надежном 
функционировании АКС. 

Контрольные вопросы к лабораторной работе №8 
1. Каковы критерии выбора решающей границы? 
2. Какие действия надо произвести, чтобы после обнаружения 

разладки, считая, что объект некоторое продолжительное время не 
меняется, снова настроить АКС? 

3. Для чего нужна нейросетевая модель объекта управления? 
4. Можно ли использовать примененную схему с АКС, если в контуре 

работает ПИ регулятор? 
5. Что показывает график изображающей точки? 
6. Как отношение 2

0
2
1 /σσ  влияет на чувствительность АКС? 

7. Можно ли при перенастройке нейросетевой модели вне контура 
изменить её архитектуру? 

8. Что такое «ошибка идентификации» и как она используется? 
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ПРИЛОЖЕНИЯ 

Приложение 1 
Statistica Neural Networks. Основные сведения 

Программный пакет Statistica Neural Networks (идентичен 
программному пакету Trajan) позволяет обучать и моделировать 
искусственные нейронные сети нескольких видов: многослойный 
персептрон, сеть Кохонена, сеть с радиально базисными функциями, 
вероятностная сеть, обобщенно-регрессионная нейронная сеть. 

Работа с программным пакетом Statistica Neural Networks 
подразумевает выполнение следующих этапов. 

1). Задание исходных данных для обучения и тестирования нейронной 
сети. Создание таблицы исходных данных выполняется с помощью пункта 
меню File->New->Data Set…. В диалоговом окне задается количество 
входов и выходов будущей нейронной сети. 

 
В открывшемся после диалогового окна редакторе (Data Set Editor) 

вводятся числовые или текстовые данные для обучения и тестирования 
нейронной сети.  

 
Количество столбцов созданной таблицы данных можно изменить 

воспользовавшись пунктом меню Edit->Variables и выбрав необходимую 
команду (Add (Добавить), Move (переместить), Copy (Скопировать), Delete 
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(удалить)). Чтобы изменить количество строк необходимо воспользоваться 
пунктом меню Edit->Cases с аналогичными командами Add, Move, Copy, 
Delete.  

Столбцы таблицы данных могут быть помечены как входы нейросети 
(Input), выходы (Output) или как игнорируемые  в процессе работы(Ignore). 
Для этого нужно выделить столбец, вызвать контекстное меню правой 
кнопок мыши и выбрать соответствующую команду. 

В ряде случаев исходные данные необходимо делить на три части: для 
обучения, для верификации, для тестирования. Для того чтобы обозначить 
часть исходных данных как данные для обучения необходимо выделить 
нужные строки таблицы, вызвать контекстное меню правой кнопкой мыши 
и выбрать команду Training. Аналогично строки исходных данных могут 
быть отмечены как данные для верификации (Verification, эти данные 
используются для контроля эффекта переобучения по ошибке 
верификации в процессе обучения), как данные для тестирования уже 
обученной сети(Test).  

2). Создание нейронной сети. Нейронная сеть создается в Statistica 
Neural Networks с помощью команды File->New->Network…. В 
открывшемся окне задается тип нейронной сети, количество входов и 
выходов, количество слоев, тип предварительной обработки данных 
(масштабирование, замена пропущенных значений в наборе исходных 
данных и т.п.).  

 
В ряде случаев оказывается полезной команда Advise, которая 

предлагает настройки сети по заданным исходным данным. Для создания 
сети необходимо нажать кнопку Create. Созданную нейронную сеть можно 
визуализировать с помощью команды Statistics->Network Illustration…. Для 
редактирования уже созданной нейронной сети предназначена команда 
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Edit->Network. Окно Network Editor позволяет задавать вид активационных 
функций в каждом из слоев нейронной сети. При необходимости изменить 
параметры предварительной и пост- обработки данных следует вызвать 
команду Edit->Pre/post processing…. 

3). Обучение нейронной сети. После создания (загрузки) исходных 
данных и создания (загрузки) нейронной сети становятся доступными 
алгоритмы обучения в пункте меню Train. При обучении сети в ряде 
алгоритмов предусмотрен расчет и построение графика ошибки обучения 
и верификации (Statistics->Training Graph).  

 
Информацию по алгоритмам обучения можно найти в разделах 

справки программы.  
4). Тестирование нейронной сети осуществляется на наборе тестовых 

данных, например, с помощью команд Run->Data set (кнопка Run) или 
Run->Single case. 
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Приложение 2 
NNACS. Основные сведения 

Программный пакет Neural network applications for control systems 
(NNACS) разработан на кафедре Управления и информатики НИУ «МЭИ» 
для выполнения учебных и несложных научно-исследовательских задач по 
синтезу и исследованию систем управления с применением нейросетевых 
алгоритмов.  Пакет ориентирован на моделирование односвязных и 
многосвязных стационарных и нестационарных систем управления в 
дискретном времени.  Нейронные сети могут использоваться для 
управления и моделирования объекта управления. 

 
Установка и настройка программного обеспечения NNACS на 

рабочее место Windows XP или Windows 7 
Файлы для инсталляции должны находиться в одной из локальных 

папок компьютера.  Из этой папки необходимо последовательно: 
1. Запустить vcredist_x86.exe, со всем согласиться и установить. 
2. Запустить ActiveTcl8.6.0.0.296563-win32-ix86-threaded.exe (или более 

новую версию) для 32-битной версии Windows, настроек не менять.  
Для 64-битной версии Windows необходимо поставить 
соответствующую 64-битную версию ActiveTcl. 

3. Запустить plotchart.bat 
4. Распаковать NNACS-1.8.2-win32.zip (или более новую версию) [14]. 
5. Каталог NNACS перенести в папку C:\Program Files (или C:\Program 

Files (x86) для 64-х разрядных версий ОС).  Для Windows 7 система 
может блокировать создание каталога и копирование в него 
исполняемых файлов.  В этом случае необходимо создать копию 
каталога NNACS в каком-то другом месте, например, в C:\nn.  В этом 
случае в переменных среды пользователя надо создать переменную с 
именем NNACSSYSDIR и значением C:\nn\NNACS. 

6. Для файла C:\Program Files\NNACS\bin\nnacs.tcl сделать ярлык на 
рабочий стол. 

7. В домашнем каталоге (C:\Documents and Settings\Пользователь – 
для Windows XP, C:\Users\Пользователь – для Windows 7) сделать 
подкаталог labworks для хранения параметров систем управления, 
нейросетей, сеансов моделирования включая данные, результаты и 
картинки.  Можно использовать произвольный каталог, например, 
C:\nn\labworks, создав переменную окружения NNACSUSERDIR с 
соответствующим значением. 

8. В этот каталог можно скопировать рабочие проекты или распаковать 
варианты заданий (обычно из файла Variants.zip).  
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Краткое описание пакета NNACS 
При запуске пакета появляется главное меню, состоящее из пунктов, 

определяющих основные действия пользователя.  Первое необходимое 
действие при работе с программой – Перед началом Выбор/создание 
нового пользователя – показывает диалоговое окно, в котором 
необходимо выбрать (кнопка Выбор)  или создать проект/пользователя 
(кнопка Создать и поле ввода имени проекта /пользователя).  Это действие 
приводит к созданию нового или выбору существующего подкаталога в 
каталоге labworks. 

Дальнейшая работа с пакетом заключается в выборе одной из рабочих 
программ, которые будут описаны ниже.  Можно одновременно запустить 
несколько разных программ, но не более одной программы каждого типа. 

При запуске каждой из программ выбирается существующий или 
создается новый сеанс работы – нумерованный каталог внутри каталога 
проекта/пользователя.  Номера состоят из трех цифр и автоматически 
инкрементируются при создании нового сеанса.  Создание нового сеанса 
возможно «с нуля» (кнопка Новый) или путем копирования 
существующего сеанса (кнопка Копия).  В последнем случае в новый 
сеанс копируются все файлы существующего сеанса. 

В списке присутствую только сеансы, подходящие запускаемой 
программе.  Кроме номера сеанса в списке показывается комментарий, 
который пользователь задавал в окне программы. 

 
Рабочие файлы пакета 

Каждый пользователь (вариант лабораторной работы) хранит файлы в 
своем каталоге, расположенном в каталоге labworks.  Внутри 
пользовательского каталога создаются нумерованные (тремя цифрами) 
подкаталоги сеансов работы с программами пакета.  Каждая программа 
полностью управляется задаваемыми ей на вход параметрами (*.par).  
Обычно содержимое этого файла формируется пользователем неявно, 
выбирая те или иные параметры или режимы работы программы. 

Параметры могут быть числовыми, а также являться ссылками на 
файлы описания нейросетей (*.nn), линейных звеньев (*.tf), произвольны 
функций (*.cof) и рядов данных (*.dat).  Файлы нейросетей и рядов данных 
могут быть как входными, так и выходными.  Линейные звенья 
описываются пользователем с помощью формул дискретного z*-
преобразования с параметрами и в вычислительных программах пакета не 
изменяются.  Использование файлов произвольных функций допустимо 
там же, где и файлов линейных звеньев.  Произвольные функции 
позволяют задавать последовательность линейных звеньев в разные 
промежутки времени для моделирования нестационарных объектов и 
регуляторов. 
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Все форматы файлов являются текстовыми.  В частности, ряды 
данных можно загрузить и визуализировать в любой подходящей 
программе (Excel, MATLAB, GnuPlot и т.п.).  В пакете приняты следующие 
обозначения для сигналов (рядов данных), образующихся в процессе 
моделирования или обучения: 

• r (r.dat) – уставка (reference signal) 
• e (e.dat) – ошибка управления (control error) 
• n (n.dat) – помеха (noise signal) 
• u (u.dat) – управляющий сигнал с выхода регулятора на вход объекта 
• y (y.dat) – выход объекта без помехи, (ny.dat) – с аддитивной 

помехой (сумма сигналов y и n) 
• d (d.dat) – ошибка идентификации, невязка (discrepancy) 
• p (p.dat) – предсказание выхода объекта моделью (plant prediction) 
• ip (ip.dat) – изображающая точка АКС (imaging point) 
Моделирование контура управления осуществляется в одном из двух 

режимов: когда и уставка, и помеха заранее подготовлены и находятся в 
файлах или если и уставка, и помеха задаются формирующими фильтрами 
из белого шума (заданными соответствующими линейными звеньями), при 
этом задается длительность моделирования в дискретных отсчетах. 

В программах пакета при задании параметров-файлов (линейные 
звенья, нейронные сети, ряды данных) можно задавать ссылки на файлы, 
сделанные в других сеансах.  Например, можно сделать в сеансе 001 файл 
с линейным звеном, описывающим объект управления: plant.tf.  После 
этого во всех остальных сеансах можно ссылаться на этот файл: 
../001/plant.tf.  Аналогично надо поступать с данными: числовые ряды 
обучающей и контрольной выборок, полученные при моделировании 
контура управления, должны быть указаны в качестве параметров 
программ обучения нейросетей. 

 
Моделирование системы автоматического управления 

Программа используется для моделирования традиционных и 
нейросетевых систем управления со стационарными и нестационарными 
элементами, стохастическими и детерминированными сигналами уставки и 
помехи.  Интерактивные возможности позволяют быстро подбирать 
параметры элементов системы управления, визуализировать результаты 
моделирования, сохранять их в графических файлах. 

Задание параметров элементов системы управления осуществляется 
при активации соответствующих элементов на схеме системы управления 
(Уставка, Регулятор, Объект, Помеха).  После задания всех параметров 
сеанс моделирование начинается нажатием кнопки Запустить.  Пример 
окна с результатами моделирования приводится ниже.  Для получения 
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этого изображения надо нажать на кнопку Графики, а потом нажать 
контрольные точки r, y и e. 

 

 
 
Диапазон визуализации данных можно изменить, задав другой 

диапазон по оси X (дискретное время) и оси Y (значение), а потом нажав 
кнопку Обновить.  Кнопки названия осей X: и Y: восстанавливают 
полный диапазон значений, доступный для визуализации.  Кнопка Ряды 
позволяет добавить в область визуализации данные (*.dat) из других 
сеансов. 

 
Обучение нейросетевого регулятора вне контура 

Программа предназначена для обучения нейросетевого регулятора вне 
контура управления по примеру другого регулятора (обычно, линейного), 
представленного в рядах данных, полученных в сеансе моделирования 
контура управления с исходным регулятором. 

Для обучения рекомендуется провести предварительно два сеанса 
моделирования, один из которых даст набор данных для обучения, а 
другой – для проверки.  Для обучения нейросетевого регулятора обычно 
требуется задать наборы данных r, e, u.  Кроме того, необходимо задать 
нейронную сеть регулятора, выбрав предварительно структуру входов.  
Возможны варианты e+r (ошибка и уставка на входе нейросетевого 
регулятора) и e+r+se (ошибка, уставка и интеграл ошибки на входе 
нейросетевого регулятора).  Диалоговое окно интерактивного задания 
архитектуры нейронной сети регулятора приведено ниже: 
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Параметры обучения и визуализации задаются в диалоговом окне, 

появляющемся при нажатии кнопки Обучение.  При запуске процесса 
обучения (кнопка Запустить) появляется окно, содержащее графики 
ошибки и коэффициентов скорости обучения: 

 

 
 

Обучение нейросетевой модели объекта управления 
Программа используется для обучения вне контура нейросетевой 

модели объекта управления.  В рабочем окне задаются файлы данных для 
обучения и проверки (Управление u, Наблюдение y или ny), а также 
нейронная сеть модели (НС-О).  Окно создания нейросетевой 
прогнозирующей модели позволяет определить набор входов и 
внутреннюю архитектуру сети: 
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Обучение нейросетевого регулятора в контуре 
Данная программа позволяет осуществить обучение нейросетевого 

регулятора в контуре управления с помощью синтезированной прежде 
нейросетевой прогнозирующей модели.  В качестве начально приближения 
обычно выбирается обученный вне контура нейросетевой регулятор. 

 
Обнаружение разладки объекта в контуре 

В данной программе используется нейросетевая модель, а также 
присутствуют блоки, реализующие алгоритм кумулятивных сумм (АКС).  
Регулятор может быть как линейным, так и нейросетевым.  Объект 
управления обычно задается нестационарным.  Файл такого объекта 
должен иметь расширение .cof.  При задании объекта управления с таким 
именем файла появляется диалоговое окно, обеспечивающее ввод 
нескольких линейных передаточных звеньев с разными параметрами и 
временем срабатывания, что и позволяет моделировать нестационарное 
поведение объекта: 
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В данной программа необходимо подобрать параметры АКС так, 
чтобы обнаружить разладку (изменение параметров объекта управления) с 
минимальной задержкой при достаточно большим этом средним временем 
ложного срабатывания. 

 
Дополнительные сведения о пакете 

В сообщениях программ пакета используются следующие 
обозначения: 

• Plant – объект управления 
• Reference – уставка 
• Min/Max/Mean – минимальное/максимальное/среднее значение во 

временном ряде 
• Dispersion – дисперсия 
• StdDev – стандартное отклонение (квадратный корень дисперсии) 
• RMS – среднеквадратическое отклонение 
• MSE – среднеквадратическая ошибка (RMS для ошибки) 
• Volume, Length – длина временного ряда 
• EtaHidden, EtaOutput – скорость обучения скрытых и выходных 

нейронов 
• Epoch – эпоха обучения 
• LearnMSE, TestMSE– СКО ошибка на обучающей и контрольной 

выборках 
• ControlMSE, IdentifMSE – СКО ошибки управления и 

идентификации 
Вещественные числа в программе должны задаваться с десятичной 

точкой, а не с запятой.  То есть, «3.14159» – правильно, а «3,14159» – 
неправильно. 

Не рекомендуется использовать русские буквы и пробелы в именах 
файлов и каталогов. 
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